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Mozilla unter der Lupe

Abstract:

Nach der langen Geburt ist Mozilla schnell erwachsen geworden. Die
Familie vermehrt sich rasch: die neuen Generationen (1.0.1 und 1.1) wurden
herausgegeben und Version 1.2 wird wahrscheinlich gerade ins Leben
gerufen.
Nach vielen Stunden des Testens und Bastelns mit den Möglichkeiten der
'Jünglinge', möchte ich nachfolgend meine Erfahrungen beschreiben.

Im ersten Teil werfen wir einen Blick auf den Umfang des
Standardbrowsers, anschliessend prüfen wir zwei der zahlreichen Add−ons.

_________________ _________________ _________________

Installation

Als erstes müssen wir eine Version auswählen. 1.0.1 ist wirklich der 'einzig echteTM' Mozilla 1.0, mit
verbesserten Sicherheitseigenschaften und  weniger Fehlern. Schätzen wir Stabilität und Kompatibilität, dann
ist das unsere Wahl. Andernfalls wählen wir 1.1 oder eine neuere Version − hier finden wir neue Funktionen.
Die Entwicklung kann man in der roadmap verfolgen.

Die Installation verlief reibungslos: einfach Linux x86 Net Installer auf der Downloadseite wählen und
ausführen ( oft in anderen Sprachen erhältlich). Die Custom−Installation mittels Net Installer (weniger als 100
kB) ermöglicht die Auswahl von erwünschten Mozilla−Komponenten und führt diese aus. Einfacher geht es
nicht.
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In der Defaulteinstellung installiert sich das Programm in /usr/local/mozilla, es kann jedoch an
anderer Stelle untergebracht werden. Es ist möglich, verschiedene Mozilla−Versionen nebeneinander zu
installieren − mein einfaches Shell−Script − /usr/bin/mozilla führt zum richtigen 'dir' und 'mozilla'
− wird ausgeführt. Die verschiedenen Versionen sind schwierig voneinander zu unterscheiden.  Unterschiede,
die ich fand, sind im nachfolgenden Text erläutert. Im Hilfemenü (Help=>About Mozilla) ist die
Version des geöffneten Programms zu finden.

Abbildung 1: Eine einfache Installation

Ein umfangreiches Programm

Mozilla ist mehr als ein Browser. Zusammengefasst ist es eine Plattform für Developer und zur persönlichen
Kommunikation (die Plattform wiederum ist unabhängig vom Betriebssystem), bestehend aus: Browser,
News/Mail−Client, Chat−Programm, HTML−Editor, JavaScript−Debugger, XML−Tools, XUL (Extensible
User Interface Language), Sammlungen von Anwendungen und Komponenten zum Downloaden, usw.

Vergessen wir jedoch nicht, dass in vielen Fällen Komponenten wie ChatZilla (der IRC Chat−Client), der
Composer, der Mail/Newsreader oder das Adressbuch nicht benötigt werden.Wenn man nur den Browser will,
ist es eine gute Idee, nur ihn zu installieren (vergiß in diesem Fall nicht, die 'Custom' Installation zu wählen.
Als einfacher Browser hat Mozilla jedoch Konkurrenz, z.B. Galeon. Dieser benutzt den Kern von Mozilla (die
Rendering Engine Gecko), ist sonst jedoch leichtgewichtiger und kleiner. Ausserdem gibt es noch Konquerer
von KDE und Opera, beides erwägenswerte Alternativen.

Mit der Wahl von Mozilla müssen wir uns damit abfinden, dass er viel Speicherkapazität benötigt. Nach
meinem Gefühl läuft er nicht 'langsam' und die Öffnungszeit hat sich seit der Version 1.0 auch verbessert.
Trotzdem benötigt Mozilla eine grosszügige Portion RAM, ebenso wie KDE. Traurig, aber wahr. Bei älteren
Systemen sollte man einen RAM−Upgrade in Betracht ziehen.

Hier eine Anmerkung: ich höre öfter, dass der Linux−Desktop im Vergleich zu Windows schwergewichtig ist.
Zugegeben, KDE ist nicht klein, wir müssen jedoch den Vergleich richtig stellen: er leistet mehr als z.B.
Windows98. Wir sollten ein aktuelles Linux mit der Serverausgabe von WindowsXP vergleichen (na ja... ;−).
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Da zeigt es sich, dass sich Linux bestens bewährt. Auf älteren Systemen sollte man  zugunsten verbesserter
Geschwindigkeit einen weniger umfangreichen Windowmanager/Desktop einsetzen. Oder wir lassen den
Desktop auf dem leistungsfähigeren Server im Netz laufen... Nach dem Hörensagen benötigt das neue Gnome
weniger Ressourcen als sein Vorgänger, das wäre eine sehr erfreuliche Entwicklung.

Ein Problem mit alternativen Browsern ist, dass einige Seiten unbrauchbar werden. Um klar zu stellen:
Mozilla ist kein alternativer Browser! Sehr wenige Sites erzeugen Fehlermeldungen oder komplette
Fehlanzeigen. Falls das auftritt, liegt der Fehler ganz offensichtlich beim Web−Designer: Mozilla folgt fast
perfekt den Standards, ein gewaltiger Fortschritt! Gratulieren wir den Developern! ( Tod den Webmastern, die
fahrlässig schlampige Websites entwerfen!)

Nachdem wir das gesagt haben, werfen wir einen Blick auf die erweiterten, neuen Eigenschaften.

Das Gute...

Die Anzahl der angebotenen Features und Optionen ist sehr beeindruckend. Wir bekommen einen ersten
guten Überblick, wenn wir durch das übersichtlich aufgebaute Einstellungsmenü browsen
(Edit=>Preferences). Nachfolgend schauen wir uns einige der Features an.

Tabbed Browsing

Tabbed Browsing ist inzwischen recht verbreitet. Es ist ein System, mit dem man mehrere Websites in einem
Fenster öffnen kann. Jede Seite hat ihren eigenen 'Tab' (Kartenreiter), klickt man auf diesen, wird die
zugehörige Seite aktiviert. Das ist äusserst nützlich, man vermeidet, gleichzeitig Dutzende von
Mozillafenstern offen zu haben. Ich benutze Tabs gerne, eines stört mich aber: warum muss für jede
Anwendung ein weiteres Multiple Document Interface erfunden werden? Mozilla hat solch ein MDI, Kate (der
KDE−Editor) , Opera und Galeon haben es ebenfalls... Jede Anwendung hat ein anderes Konzept und andere
Shortcuts. Und dann ist da noch KDe selbst, das Fenster desselben Programms unter einer einzigen
Schaltfläche in der Taskleiste anordnet. Gesamt betrachtet ein sehr verwirrender Zustand − letztendlich glaube
ich jedoch, dass Mozilla eines der besseren Systeme hat. Zu bemerken ist noch, dass Konquerer von KDE 3.1
an auch Tabbed Browsing  unterstützen wird.

Wir sollten einen Blick auf die Optionen des Tabbed Browsing werfen. Ich ziehe es vor, Tabs in den
Hintergrund zu laden und durch Klicken der mittleren Maustaste auf einen Link einen neuen Tab zu öffnen.
Wir können auch konfigurieren, dass Control+Enter einen neuen Tab in der Adressleiste öffnet. Das
Beste an den Tabs sind die Tasteneinbindungen: Control+T  öffnet einen neuen, leeren Tab, 
Control+Page Up und Control+Page Down  wechseln zwischen Tabs, und  Control+W  schliesst
den aktuellen Tab. Als letztes: Control+L wählt den Text in der Adressleiste (URL).

Lesezeichen

Ein nettes Feature der Lesezeichen (für die ein umfassendes Verwaltungssystem exisitiert) ist die Eigenschaft,
mehrere Tabs unter einem Lesezeichen speichern zu können durch (Bookmarks=>File Bookmark), und
dann 'File as group' wählen. In Version 1.1 geht es noch schneller: einfach Bookmarks=>Bookmark
This Group of Tabs auswählen. Das ist sehr nützlich, um einige der gebräuchlichen News−Sites zu
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öffnen, oder um heute auf den Seiten zu surfen, die man gestern offen hatte. Ein kleines Feature von
Konquerer vermisse ich, mit dieser konnte man nicht nur Add to Bookmarks im Hauptmenü , sondern
auch im Untermenü ausführen. Ich werd's wohl überleben ;−) .

Die Sidebar

Mit F9 aktiviert man die Sidebar (oder schliesst sie :−). Klickt man auf ihren Rand, verkleinert sich die Breite
auf ein paar Pixel. Welchen Vorteil die Sidebar gegenüber einer angenehm schlichten Webseite haben soll, ist
mir schleierhaft. Ich vermute jedoch, dass Netscape sie häufig in seinen Browsern benutzt. Innerhalb der
Sidebar findet man Tabs wie 'Suche', 'History', 'What's related' und  'Lesezeichen'.

Glücklicherweise kann man alternative Sidebars einführen, die mehr dem persönlichen Geschmack
entsprechen, es besteht eine grosse Auswahl. Ich habe einige ausprobiert, die Informationen über die Tags der
Dokumentformate HTML, XHTML und SVG enthalten (von zvon.org, die übrigens ihre Übersetzungen auf
die gleiche Weise wie LF durchführen). Installation der Sidebars ist recht einfach: klicken, 'OK' wählen und
das war's dann schon, selbst wenn man nicht 'root' ist. Persönlich hätte ich gerne eine Sidebar, über die man
die aktuelle Seite durch validator.W3.org validieren kann. Als etwas bequemer, jedoch nutzbringender
HTML−Verfasser, würde ich das echt begrüssen ;−)

Privatsphäre und Sicherheit

Auf diesem Gebiet überragt Mozilla. Es gibt viele Features und Möglichkeiten in Bezug auf
Cookie−Management und Popup−Unterdrückung.. − ich empfehle die Optionen, die nur Grafiken und
Cookies der aktiven Webseite des Webservers zulassen. Das stoppt oder behindert bereits einige der
Reklamenetze. Ausserdem ist es möglich, einzelne Cookies zu lesen und zu entfernen sowie zu wählen,
welche Seiten die Erlaubnis haben, Cookies zu setzen. Mozilla kann uns auch für jeden Cookie um Erlaubnis
zu fragen oder es kann uns mindestens an diese Möglichkeit erinnern. Wir sollten uns auch überlegen, ob
Java, JavaScript und Cookies wirklich nötig sind und diese so weit wie möglich abstellen (in der
Default−Einstellung akzeptiert Mozilla alle Cookies und JavaScript ist berechtigt Popups zu öffnen) − das
sollten wir umgehend abschalten.

Mozilla kann sich auch an Passwörter und Eintragdaten in Formulare erinnern, das stelle ich sofort ab (...dem
traue ich einfach nicht).

Erscheinungsbild

Wir können aussuchen, welche Schaltflächen auf der Symbolleiste erscheinen sollen − 'Startseite','Suchen',
'Drucken', 'Gehe' und 'Lesezeichen' sind meiner Ansicht nach nicht notwendig. Das schafft mehr Platz für das
Display der URL. Konfigurierbar in Edit=>Preferences=>Navigator.

Das Aussehen des Default−'Classic'− Theme gefällt mir nicht wirklich. Es erinnert an das alte, graue Netscape
4 und macht es schweierig, den aktiven Tab zu sehen. Im Vergleich zu Classic finde ich das Modern−Theme
viel besser. Im Web sind verschiedene andere Themes erhältlich, jeder sollte sein Lieblings−Theme dort
finden können. Für kleinere "displays" würde ich ein "tiny" Theme empfehlen. Ich selbst benutze das bunte,
kleine 'Orbit 3m'.
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Abbildung 2: Drei Themes: Classic, Modern und die kleine Version von Orbit, 'Orbit 3m'.

Smart Browsing

Beim Smart Browsing braucht man die URL vielfach nicht einzutippen. Da gibt es die 'Internet Keywords'
(Schlüsselwörter, von Netscape favorisiert), wie 'Suchen', 'Quote',  'Hilfe',  'Gehen zu' − diese werden beim
Eintippen in die Adressleiste erkannt (z.B. 'search linuxfocus' oder 'goto linuxfocus'). Mozilla erkennt die
Keywords und öffnet bei Anwendung der richtigen Parameter die gewünschte Seite. Das einzige, was mir
dabei zusagt, ist die Möglichkeit − mittels JavaScript − persönliche Schlüsselwörter für unsere bevorzugten
Webseiten hinzufügen zu können. Mozillas Standardeinstellung für seine Suchmaschine ist Netscape.com
(aber Google.com ist ebenfalls eine Option). Beim Eintippen eines Suchworts in die Adressleiste wird die
Suchmaschine aktiv. Einige der von mir getesteten Mozillaversionen hatten dieses Feature nicht.
Zusammenfassend möchte ich bemerken, dass ich mich nicht so recht an die Internet Keywords gewöhnen
konnte − ich habe das Feature abgeschaltet. Vielleicht ist es nützlich für Leute, die sehr langsam tippen :−)
Eine andere Funktion des Smart Browsing ist das automatische Vervollständigen ('location bar auto
complete') in der Adressenliste, die meisten Browser haben das. Ich bin nicht sehr hingerissen davon :−)

Type Ahead Find

Mozilla 1.2, von dem ich nur die Alpha−Version testen konnte, enthält das neue Feature 'Type Find Ahead'.
Das ist eine elegante Methode, ohne Maus zu navigieren: man tippt nur einen Teil des gewünschten Links und
Mozilla wählt den Rest aus. Mit Enter aktualisiert man den Link. Ein Beispiel: Wir wollen den nächsten
Link in der Folge dieses Artikels aktivieren (siehe weiter unten 'Plugins und Mozilla 1.0'), so geben wir
plu+Enter ein und Mozilla erledigt den Rest. Sobald man einige Übung mit  Tasteneinbindungen hat, ist es
sehr einfach, mittels Texteingaben zu navigieren, ohne zwischen Maus und Tastatur wechseln zu müssen.
Eine andere nette Eigenschaft ist die Möglichkeit, in normalem Text zu suchen, indem man einen /slash der
Suche voranstellt. Weiteres Nützliches: Escape beendet die aktuelle Suche, und mit (Shift+)F3 kann man
vorwärts oder rückwärts suchen.

Abbildung 3: Type Ahead Find aktiviert den richtigen Link auf der LinuFocus−Hauptseite nach der Eingabe
von 'cast'
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... und das Nützliche

Neben den gewohnten Features bietet der Browser noch viele Extras. Mozillas offenes System macht es
ziemlich einfach, Erweiterungen anzubauen − das scheint sich zu ausgezahlt zu haben.
Da gibt es die gewohnten Plugins (siehe im Artikel: Plugins und Mozilla 1.0), als auch Sidebars, die als
vollständige Anwendungen erscheinen, sowie weitere Add−ons, wie z.B. Ad−Blocker, Anonymes Surfen,
Kalender,  Jabber Messenger, einen Site−Downloader, usw. Aus Zeitmangel können wir hier nicht auf alle
eingehen. Die Links am Ende des Artikels, besonders MozDev, führen zu vielen Add−ons. Die folgenden
wurden von mir getestet.

Die Muttersprache

Mozilla spricht natürlich Englisch, ist jedoch nicht darauf beschränkt. Andere Sprachen sind einfach zu
installieren: wir klicken uns durch Edit=>Preferences=>Appearance=>Languages/Content auf
die Seite mit der Liste der Übersetzungen. Mit 'root'−Zugang lässt sich die Installation mit ein paar Klicks
durchführen, vorausgesetzt Mozilla wehrt sich nicht ( er hat mir einmal die Übersetzung verweigert,
funktionierte sonst jedoch wie immer reibungslos). In einigen Sprachen (oder in allen?) entdecken wir, dass
die Shortcuts nicht übersetzt wurden. Das ist einerseits bequem und andererseits teilweise störend. Ich hörte,
dass die Übersetzung der Shortcuts nicht ohne Konflikte verläuft und es besteht keine Softwarelösung, um
diese zu beseitigen. Hier sei auch zu erwähnen, dass nicht alle Mozilla−Ausgaben in die gewünschte Sprache
übersetzen, wir können hier herausfinden, was vorhanden ist.

Wenn Englisch nicht deine Muttersprache ist, vergiß nicht, deine gewünschten Sprachen einzustellen
(Navigator=>Languages) einstellen. Einige Webseiten erscheinen als Ergebnis automatisch in der
übersetzten Version (z.B. debian.org).

Mouse Gestures

Auf der Webseite von MozDev.org stiess ich auf das Projekt Optimoz. Diese Leute schufen zwei der besseren
Add−ons: Mouse Gestures und RadialContext. Mouse Gestures (auch bekannt unter MozGest) ist ein
Programm, das es ermöglicht, den Computer mit Mausbewegungen anstelle von Schaltflächen und Menüs zu
kontrollieren. Mit einer gedrückten Maustaste zeichnet man ein Symbol und führt damit ein Kommando im
Browser aus. Das Windows−Spiel 'Black & White' z.B. benutzt solche Mausbewegungen, ebenso die
Windows−Version des Browsers Opera. Eine Liste der definierten Mausbewegungen kann man hier bei
Optimoz anschauen. Es ist auch möglich, eigene Mausbewegungen zu entwickeln, indem man den Code des
Programms in JavaScript editiert.

Abbildung 3: Optimoz Mouse Gestures Banner...

Die Installation ist wie üblich problemlos − vorausgesetzt man hat 'root'−Rechte. Mit Mouse Gestures zu
spielen, hat mir echt Spass gemacht, ich muss jedoch gestehen, dass ich nicht süchtig geworden bin. Auf
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Tasten zu drücken oder Shortcuts zu benutzen ist genauso schnell − manchmal wurde eine Mausbewegung
von der Software falsch interpretiert, bzw. wurde von mir falsch ausgeführt. Aber die Möglichkeit, eigene
Mausbewegungen zu erfinden, ist sehr vielversprechend...

RadialContext

'RadialContext'− ebenfalls von Optimoz − ist eine Anwendung des sogenannten Tortenmenüs (pie menu).
Eine Art rundes Menüsystem, das sich um den Cursor als Mittelpunkt orientiert. Durch Bewegung des
Mauszeigers in eine der vier (oder acht) Richtungen öffnet sich ein Auswahlmenü. Es ist schwierig zu
erklären, aber wenn du Mozilla benutzt, kannst du es selber sehen, surfe einfach auf diese Seite, um das Look
and Feel in Aktion zu erleben. Diese Demonstration hat keinerlei Effekt auf unser System − dafür muss man
RadialContext selbst erst installieren (was mit 'root'−Zugang natürlich wieder sehr einfach ist).

Abbildung 4:Eine Ansicht von RadialContext: das Hauptmenü, das Tab−Menü und das Grafik−Menü mit
Hilfstext.

In der Grafik sehen wir die Standardausführung des Tortenmenüs mit je einem Sektor für die Richtungen
'Oben', 'Unten', 'Links' und 'Rechts'. Dazwischen sind vier Untermenüs, auf die wir durch Bewegen des
Mauszeigers mit gedrückter Taste diagonal in eines der Felder. Oben rechts findet man z.B. ein Menü für die
Tabs (mittlere Grafik). Dieses Untermenü enthält Funktionen zum Öffnen, Schliessen, sowie zum Aktivieren
des nächsten oder vorhergehenden Tab. Das ist sehr nützlich, um ohne Tastatur zu browsen. Die anderen
Menüs enthalten Funktionen für die Fenster, Tasks und Seiten. Die vier Grundfunktionen des Hauptmenüs
sind: Seite aktualisieren, Laden stoppen, in der History vorwärts bzw. rückwärts gehen. Über einer grafik
benutzt, bekommen die vier Hauptrichtungen andere Funktionen, wie man im rechten Teil der Grafik sehen
kann. Hier können wir auch sehen, was passiert, wenn wir die Maus für eine Weile nicht bewegen: ein
Erklärungstext erscheint neben dem Auswahlmenü. Über einem Link ändert sich das Auswahlmenü wieder,
jetzt zeigt es Funktionen, um den Link in einem neuen Fenster oder mit einem neuen Tab zu öffnen, den Link
zu kopieren oder das Ziel zu speichern.
Einen guten Überblick, wie diese Menüs aussehen, finden wir  hier.

Natürlich können wir konfigurieren, welche Maustaste RadialConcept zugeordnet werden soll.
Selbstverständlich gibt es eine Taste, um die Maus auf ihre "normale" Benutzung zurückzustellen. Ein Rat:
RadialConcept und MozGest gleichzeitig zu benutzen, verwirrt den Browser nur. Mögliche Verbesserungen
(nach meinem Geschmack): einMenü, das sich nicht mehr bewegt, sobald es erschienen ist und das
Erscheinen der kleinen Hilfs−Textfenster als Standardeinrichtung, d.h. ohne Wartezeit...

Auf meinem System ist Mouse Gestures fast immer abgestellt (einfach im Einstellungsmenü auszuführen),
RadialContext dagegen benutze ich sehr viel. Meistens warte ich nicht einmal bis dessen Menü erscheint, ich
habe viele Schritte im Gedächtnis und eine falsche Bewegung ist sehr selten. Mit meinen Händen auf der
Tastatur benutze ich oft Shortcuts. Finde ich jedoch nicht, was ich brauche, hilft mir das kleine, runde Menü
fast immer weiter. Es ist ein innovatives, leistungsfähiges Programm − ich vermisse es in anderen Browsern.
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Hinzu kommt, dass RadialConcept regelmässig upgedated wird − mein Urteil: ich empfehle, das Programm
auszuprobieren.

Anfscd(*): Mozilla & Präsentationen

(*) : And now for something completely different (Und nun zu etwas völlig anderem).

Es gibt Tausende von Möglichkeiten, um Präsentationen auszuführen, die Software dafür ist fast ebenso
zahlreich. Die populärsten Programme sind unter anderem Open Office, KPresenter und PDF− oder
Postscript−Leser. Ignoritert man die letzten beiden, so benutzen die meisten Programme ihr eigenes Format
oder das von Microsofts Powerpoint. Als Resultat können nicht alle Präsentationen auf jedem System gelesen
werden. Das ist ein großer Nachteil, wenn man einen fremden Computer benutzen muss.

In der Praxis funktioniert HTML ganz ordentlich, um eine solide Präsentation zusammenzustellen, besonders
wenn man Stylesheets verwendet. Damit ist das Display auf allen gebräuchlichen Plattformen gewährleistet.
Steht Mozilla zur Verfügung (unter Linux erst ab1.1 an aufwärts ), kann man mittels F11 auf das
Gesamtbild schalten.
Man kann auch die Präsentation in selbstgebastelter XML − Sprache beschreiben und mit Hilfe von CSS in
ansprechender Form vorführen. Das beinhaltet jedoch das Risiko, auf Browser zu stossen, die XML oder CSS
nicht ausreichend unterstützen. Mit Mozilla funktioniert es jedenfalls, ich habe es ausprobiert.

Verwirren all diese kleinen Schaltflächen die Betrachter der Präsentation im Gesamtbild?
View=>Show/Hide=>Navigation Toolbar löst das Problem. Mit RadialContext erübrigen sich
andere Schaltflächen und Menüs. Eine Adresse kann man immer noch mit strg+L einfügen.
So, bevor wir mit unserer Präsentation beginnen, sollten wir nicht vergessen, die Seite etwas kleiner als den
Bildschirm zu machen − sonst wird unsere Bildlaufleiste (Scrollbar) verdeckt...

Links

galeon.sourceforge.net : Galeon, ein leichtgewichtiger Browser, der auf der Render−Engine von
Mozilla beruht.

• 

opera.com : Opera, ein guter, kleiner Browser für Linux und andere.• 
mozilla.org : offizielle Webseite der Mozilla − Entwickler.• 
mozilla.org/releases/stable.html : Hier findet man die stabilen Installationsprogramme. Weniger
stabile, neuere Versionen sind hier zu finden.

• 

mozilla.org/start/1.0/ : die Default−Startseite von Mozilla 1.0 hat gute Informationen.
mozillazine.org : online magazine 'bout the moz'.

• 

mozdev.org : ist Homepage von mehr als 70 Mozilla−Projekten. Hier ist die eindrucksvolle Liste.• 
optimoz.mozdev.org : Optimoz, Quelle von 'Mouse gestures' und 'RadialContext'.• 
OperaShow : benutze Opera und Stylesheets für Präsentationen.• 
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